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1 Introduction

1.1 What is GnuCash?

GnuCash is a free accounting program for managing personal and small business
finances. It runs on computers that use the GNU/Linux operating system.

GnuCash performs a similar job to some popular non-free applications that
run on versions of the Microsoft Windows operating system: Quicken and Mi-
crosoft Money. However, GnuCash has (at least) one major advantage compared
to those other products: the source code for GnuCash is freely available. Anyone
can extend and improve GnuCash.

1.2 This Document

This document is a user guide for GnuCash. It describes many of the features
available in GnuCash,1 hopefully in a way that will help people to get more
value from the application.

You can download the latest version of this document from:

http://www.object-refinery.com/gnucash/index.html

You are permitted to copy and/or distribute this document free of charge,
but you may not modify its content in any way.

1.3 Updates

I plan to continue updating and enhancing this guide, as time permits. If you
would like to accelerate this process, please consider sponsoring the development
of the guide by “buying” your copy of the guide. The price is US$24.95, and
you can pay by credit card via the Kagi online store:

http://order.kagi.com/?JBN

Purchase is appreciated, but not required.

1.4 Important Notice

Before you read any further, you should note the following points:

• this document aims to describe how the GnuCash application works, not
how you should arrange your financial affairs. Nothing in this document
should be considered as financial advice. You should consult a professional
financial adviser if you are unsure of the best way to manage your finances.

• I believe that the descriptions in this document are accurate—however, I
cannot guarantee that this is the case. You must use the information in
this document at your own risk, or not use it at all.

• I am not a GnuCash developer, nor am I directly involved in the GnuCash
project. I simply use GnuCash on a regular basis to manage my personal
and business finances.

1At the time of writing, I am using GnuCash version 1.6.2 on SuSE Linux 7.3.
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1.5 Feedback

I am happy to receive feedback about this document. Please send e-mail to:

david.gilbert@object-refinery.com
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2 More About GnuCash

2.1 The Gnome Project

GnuCash is part of the Gnome project, which “has built a complete, free and
easy-to-use desktop environment for the user, as well as a powerful application
framework for the software developer”.2 You can find out more about Gnome
at:

http://www.gnome.org

In particular, you may be interested to find out more about some of the
other free applications that are being developed for Gnome (for example, the
Gnumeric spreadsheet).

2.2 GnuCash Development

GnuCash has been under development since 1997, by volunteers from all over
the world. There is some information about the history of GnuCash (for those
that are interested) in the online documentation that is included with GnuCash.

Other information about the GnuCash project can be found at the official
GnuCash website (an excellent source of information for both users and devel-
opers):

http://www.gnucash.org

The latest (stable) version of GnuCash is 1.6.6.

2.3 The GnuCash Licence

GnuCash is licensed under the terms of the GNU General Public Licence (GPL).
This means that GnuCash is “free software”, as defined by the Free Software
Foundation. There is more information about the GPL and the Free Software
Foundation at:

http://www.fsf.org

The GPL fits the criteria of the Open Source Definition, which means that
GnuCash is “open source”. You can find out more about open source software
at:

http://www.opensource.org

2.4 Versions

As mentioned previously, the latest stable version of GnuCash is 1.6.6. New
versions are released fairly frequently.

Many people will be using an older version of GnuCash. For example, I am
using version 1.6.2 (installed by default with SuSE Linux 7.3). It makes sense to
have an up-to-date version of GnuCash, but don’t feel that you have to upgrade
to the very latest version, unless:

2Quote from the Gnome web site.
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• there is a bug in your version of GnuCash that is affecting you directly,
and you know that the bug has been fixed in a more recent version of
GnuCash.

• there is a new feature in a more recent version of GnuCash that is going
to make a big difference to you.

Upgrading GnuCash requires some technical knowledge and will take a rea-
sonable amount of your time. It also entails some risk. Weigh up the costs and
benefits before proceeding with an upgrade.

2.5 Getting Support

Support for GnuCash is provided on a voluntary basis via the GnuCash user
mailing list. There are many subscribers to this list (including many of the
GnuCash developers) and it is rare for questions to go unanswered for very
long.

Before you can post a question, you need to subscribe to the mailing list
(follow the instructions on the GnuCash web site). Once you have subscribed
to the list, you will receive all messages that any other subscriber sends to the
list. When you send an e-mail to:

gnucash-user@lists.gnucash.org

...it will be delivered to all subscribers on the list (hundreds, perhaps even
thousands, of people, so think about what you write before you post your mes-
sage). In particular, before you post a question, be sure to:

• review the GnuCash documentation. It wastes everybody’s time if you
ask a question about something that is already well documented.

• search through the mailing list archives to see if your question has already
been asked before (again, to avoid wasting everybody’s time).

• make sure you have gathered together all the information that might be re-
quired to answer your question (don’t forget to include the version number
of GnuCash that you are using).

Some free software projects have a frequently asked questions (FAQ) file that
contains answers to the most common questions asked by users. As far as I am
aware, there is no FAQ for GnuCash.

2.6 Reporting Bugs

If you find a bug in GnuCash, you should report it to the GnuCash developers
so that it can be fixed. GnuCash bugs are recorded in the Bugzilla database at:

http://bugzilla.gnome.org

When you submit a bug report, you should:

• always include the version number of GnuCash that you are using.
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• if you built GnuCash from source, say so, otherwise state the Linux dis-
tribution that you use GnuCash on.

• if something doesn’t work, state what happened and what you expected to
happen.

• list the steps to reproduce the problem.

• remember that the developers are volunteers, so be polite.

The GnuCash developers have worked hard (and continue to work hard) to
make GnuCash a valuable application for everyone to use. You can repay them
(a little) by providing quality bug reports. And quality bug reports take time
to prepare.
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3 Basic Accounting

3.1 Introduction

In order to get the best out of GnuCash, you need to understand a few basic
accounting principles (do not be alarmed though, you do not need to be an
accountant to use GnuCash). This section contains a brief overview of these
accounting principles.

3.2 Accounts and Transactions

3.2.1 Accounts

Accounts are used to record all the financial transactions for a person, a business,
a charity, or any other accounting entity. There is no limit to the number of
accounts that can be used by an accounting entity—new accounts can be created
as required.

There are five fundamental account types:

Account Type: Description:

Asset Asset accounts represent things that have value to you.
Typical assets include cash in the bank, stocks you
own, your car, your house, some money you lent to
someone.

Liability A liability account is the opposite of an asset account.
Typical liabilities include your mortgage, your credit
card accounts, some money you borrowed from some-
one.

Income Income accounts are used to record income. Typical
examples include your salary, dividends and interest
earned on bank deposits.

Expense Expense accounts are used to record expenses. Typical
examples include rent, electricity, food and entertain-
ment.

Equity Equity accounts represent your net wealth at a point
in time (more about this later).

3.2.2 Transactions

A transaction records an exchange of value between two accounting entities.
Every transaction has a value, expressed as a monetary amount and recorded in
one account as a debit entry and in another account as a credit entry. Entering
all transactions in two accounts, in one as a “debit” and in the other as a
“credit”, follows a principle known as double-entry accounting.

3.2.3 Account Balances

Every account has an account balance, which results from the transactions
recorded in that account. The account balance is the difference between the
total of all the debit transactions in the account and the total of all the credit
transactions in the account.

If the sum of the debit transactions is greater than the sum of the credit
transactions, then the balance is called a debit balance. If the sum of the credit
transactions is greater than the sum of the debit transactions, the the balance is
called a credit balance.
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3.2.4 Debits and Credits

Why use the terms debit and credit, when transactions just involve adding value
to one account and subtracting value from another account? Similarly, why say
an account has a debit balance or a credit balance, instead of a positive balance
or a negative balance?

The idea of “adding” and “subtracting” is particularly intuitive when we
are talking about a bank account—adding to the balance is good (we have
more money), subtracting from the balance is bad (we have less money). This
“intuition” makes it tempting to use this convention for all accounts, rather
than taking time to learn the meaning of “debit” and “credit”.

But do not be fooled. Adding and subtracting soon become ambiguous
when dealing with other account types. For example, what about the balance
outstanding on your mortgage (if you have one)? Do you think of this as a
negative number or a positive number? The fact is, you can argue the case for
either approach.

I tend to think of the balance of my mortgage as a positive number, but of
course making a mental note that it is money that I owe to the bank. So when I
pay (add?) money into my mortgage account, it reduces (subtracts from?) the
balance.

Someone else might consider it more logical to consider the balance of their
mortgage as a negative number. After all, a mortgage is like a large overdraft.
When that person pays (adds?) money into their mortgage account, the balance
increases (or becomes less negative).

The point is not whether one way or the other is correct, but rather that
different people will look at it in different ways. But if you follow the (account-
ing) convention that assets have debit balances and liabilities have credit
balances, then the ambiguity is removed.

3.3 The Accounting Equation

The accounting equation specifies a relationship between the totals of the bal-
ances in the five account types. The equation states:

Assets - Liabilities = Equity + (Income - Expenses)

The left hand side of the equation represents your assets and liabilities.
The right hand side of the equation represents your net wealth (Equity) at the
beginning of the current accounting period, plus any change in net wealth since
the beginning of the current accounting period (Income - Expenses).

3.4 Double Entry Accounting Examples

If you follow the principle of double entry accounting (matching every debit
transaction with a corresponding credit transaction), the accounting equation
will always hold true.

Suppose you receive $100 income. You would record this by recording a
debit in your bank account (an asset). At the same time, you would record a
credit in your income account. Now the equation looks like this:

Assets - Liabilities = Equity + (Income - Expenses)
$100 - 0 = 0 + $100 - 0
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Now suppose you pay $30 rent. You would record this by putting a credit
entry in your bank account (decreasing the value of the asset). At the same
time, you should put a debit entry in an expense account. Now the equation
looks like this:

Assets - Liabilities = Equity + (Income - Expenses)
$70 - 0 = 0 + $100 - $30

It still balances! Now suppose you borrow $50 from your bank. Your bank
account balance increases (debit $50). You should also record a liability to the
bank by crediting a liability account with $50. Now the equation reads:

Assets - Liabilities = Equity + (Income - Expenses)
$120 - $50 = 0 + $100 - $30

Notice how this transaction only affected one side of the equation, but it still
balances because the assets and liabilities both increased by the same amount.

Double entry accounting keeps your accounts consistent. It is still possible
to make mistakes and record a transaction incorrectly, but it is always easier to
correct mistakes if you can be sure that the account balances are consistent.

While accountants use the terms debit and credit, GnuCash does a good job
of presenting more intuitive terms (such as deposit and withdrawal for a bank
account), so don’t worry if, initially at least, you find the terms debit and credit
confusing.

3.5 Equity Accounts

Equity accounts, in the personal accounting context, represent your net wealth
at a point in time. If you started your accounting records on the day you were
born, you would have zero balances in your equity accounts, since your net
wealth on the day you are born is zero (unless you have generous relatives).

On the other hand, if you start your accounting records later in life (very
common!) then you already have a net wealth (hopefully positive) which you
need to record somewhere. You use equity accounts for this purpose.

As time goes by, you will receive income and incur expenses. Income and
expenses change your net wealth and, in a sense, income and expense accounts
are a special type of equity account. It is common practice to transfer, at the
end of an accounting period (usually one year), all the balances of income and
expense accounts to an equity account. This resets the balances of the income
and expense account to zero, without losing the net effect on net wealth (since
this amount is now reflected in the equity accounts).

3.6 Looking Back

If you take another look at the accounting equation stated previously, you’ll
start to see that one side of the equation (assets minus liabilities) represents
your net wealth. And the other side of the equation (equity plus income minus
expenses) also represents your net wealth.

The value of the accounting equation, and double-entry accounting, is not
in showing that your net wealth is equal to your net wealth. You already knew
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that! But it provides a framework within which you can look at subsets of your
transactions and extract valuable information from them.

Your assets have been separated from your liabilities, your income has been
separated from your expenses. You can analyse different accounts through dif-
ferent time periods, and at all times you can remain confident that everything
consistently ties together to provide an overall picture of your financial position.
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4 Accounts in GnuCash

4.1 Account Types

Recall, from the previous section, that all accounts can be classified into five
account types: income, expenses, assets, liabilities and equity. GnuCash actually
has eleven account types, because it creates additional asset and liability account
types:

Account Type: GnuCash Account Types:

Income Income

Expense Expense

Asset Asset, Bank, Cash, Share, Unit Trust, Currency
Liability Liability, Credit Card

Equity Equity

GnuCash uses these additional asset and liability account types because at
certain times it needs to know more specifically what kind of asset or liability
it is dealing with. This is particularly true in selecting accounts to be included
by default in certain reports.

4.2 The Chart of Accounts

GnuCash, like most accounting systems, organises accounts into a structure
called the chart of accounts. In GnuCash, the chart of accounts is a hierarchical
structure commonly referred to as the account tree.

You have a great deal of flexibility in determining the order and grouping of
accounts in the GnuCash account tree. The structure you choose, however, will
impact the format and layout of the reports that you generate from GnuCash.

GnuCash can create a default account tree for you, via the new account
hierarchy setup druid. This is a good starting point, because the accounts it
creates are laid out in a logical manner.

4.3 Creating a Set of Accounts

To create a new set of accounts, select the New File menu item from the File
menu in the main GnuCash window. This automatically launches the new
account hierarchy setup druid :

The first window contains information only—read it, then click on the Next
button. The next window allows you to choose the currency for your set of
accounts:

13



Select the appropriate currency, then click on the Next button. The next
window contains a list of common account categories:

Select the categories that are appropriate for your finances. As you select
each item, a summary is displayed, showing the accounts that will be created.
When you are happy with your selections, click on the Next button to proceed
to the opening balances window:

On this window, you can enter opening balances for any accounts that require
them (typically your asset and liability accounts). GnuCash will automatically
enter transactions in your new set of accounts to create these balances. When
you are done entering opening balances, click on the Next button to proceed.
The final window informs you of your options:

14



Click the Finish button to create the new set of accounts, the Back button
to review the information you have entered, or the Cancel button if you do not
want to create any accounts.

4.4 Creating An Account

You can create additional accounts in your account tree at any time. To create
a new account, select New Account... from the Account menu:3

You need to enter an account name and a description. Then you should select
an account type, and select the parent account (or New top level account if
this account should appear at level 1 in the account tree).

You can specify an account code which determines the ordering of the ac-
counts in reports. The account code is typically a number (integer). GnuCash
goes one step further and treats the account code as a base-36 number, using
the letters A-Z to represent the digits 10 to 35.

4.5 Entering Transactions

4.5.1 Overview

Once your accounts are defined, entering transactions is relatively straightfor-
ward. Although transactions can transfer money between any two accounts in

3The Account menu is only available while you are viewing the accounts tree in the main
GnuCash window.
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your account tree, for most people the bank (cheque or checking) account is the
most commonly used account. Most transactions can be entered via the account
register window—double click on an account in your account tree to open the
account register window:

A blank transaction appears at the bottom of the account register window.

4.5.2 The Date Field

By default, the date field is selected and displays today’s date. You can enter
dates in several different ways:

• type the date (make sure you use 4 digits for the year).

• use the mouse to select a date from the drop-down calendar.

• use short-cut keys to select a specific date.

The date short-cuts are worth remembering. Try them out now (while you
have the date field selected):

Shortcut: Description:

t Enters today’s date.
- Subtracts one day from the current date.
= Adds one day to the current date.
[ Subtracts one month from the current date.
] Adds one month to the current date.
m The first day of the month currently in the date field.
h The last day of the month currently entered in the date field.
y The first day of the year currently in the date field.
r The last day of the year currently entered in the date field.

The keys for the start of the month and the end of the month have been
chosen for easy recall:4 m is the first letter in the word Month, and h is the last
letter.

Likewise, the keys for the start of the year and the end of the year have also
been chosen for easy recall: y is the first letter in the word Year, and r is the
last letter.

4At least for English speakers. I’m not sure how this is handled in the foreign language
versions of GnuCash.
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4.5.3 The Description Field

Next, you should enter a description for the transaction. This can be any text,
and should explain what the transaction is for. You can always update the
description later, so don’t agonise for too long over it.

GnuCash will use the description you enter to auto-complete the remaining
fields for the transaction. The details of the last transaction with the same
description are copied to the current transaction. This can be a great time
saver.

4.5.4 The Transfer Account

A very important choice is the transfer account. In order to follow the double
entry accounting principle, all transaction items in one account must be offset by
another transaction item of an equal and opposite amount in another account.
GnuCash makes this easy for you—while you are entering a transaction item
in one account, you specify the transfer account and GnuCash automatically
updates that other account for you. In the next section, we describe some of the
more common transaction types, and how you should enter them in GnuCash.

You can choose the transfer account from a drop-down list. If you have a lot
of accounts, this list can be very long, so GnuCash provides some more keyboard
shortcuts. As you type the account name, GnuCash will automatically select
an account that matches what you have already typed. Try it out...

4.5.5 The Amount Field

The final field you must complete is the amount field. You need to enter the
amount in the correct column, according to the type of transaction. Fortunately,
GnuCash labels the columns in an intuitive way—if you are using a bank ac-
count, for example, the headings withdrawal and deposit appear as the account
headings.

4.6 Common Transaction Types

New users are often unsure how to record certain transaction types. To get you
started, a few of the more common transaction types are described here, along
with some notes on how to record these in GnuCash.

4.6.1 Income Received

Typical income for a person includes one or more of the following items:

• salary or wages – regular income from your employer.

• interest – income from bank deposits.

• dividends – income from share investments.

All of these income items increase your bank balance, so you need to enter
a debit transaction item in your bank account. At the same time, you need to
record the receipt of income by entering a credit transaction item in an income
account. You could record all your income in a single income account, but the
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financial reports you can generate from GnuCash will be more meaningful if you
create a separate income account for each type of income you receive.

Income transactions are automatically shown on the Profit and Loss Report.

4.6.2 Expense Paid

Typical expenses for a person will include some of the following items (as well
as others):

• rent – accommodation.

• food – groceries.

• utility bills – gas, electricity, water.

• overdraft interest – a financial expense for borrowing money from the
bank.

All of these expense items decrease your bank balance (or increase your
credit card liability), so you need to enter a credit transaction item in your
bank account or credit card account. At the same time, you need to record
the expense by entering a debit transaction item in an expense account. You
could record all your expenses in a single expense account, but the financial
reports you can generate from GnuCash will be more meaningful if you create
a separate expense account for each type of expense you have.

Expense transactions automatically appear on the Profit and Loss Report.

4.6.3 Withdrawing Cash From Your Bank Account

There are two ways you can account for cash withdrawals from your bank ac-
count. The first is to treat the transaction as a miscellaneous expense—this
approach is OK if you only withdraw small amounts of cash, and don’t really
care to account for every last penny (or cent).

The other approach is to maintain a separate cash account, and transfer
money from your bank account to the cash account to represent cash with-
drawals. Then, you need to record expenses against your cash account. This
approach is more accurate, but it requires you to be more conscientious about
recording transactions.

4.6.4 Depositing Cash in Your Bank Account

This is the exact reverse of withdrawing cash from your bank account. You need
to record the source of cash in an income account.

4.6.5 Transfer Between Bank Accounts

When you transfer money between bank accounts, you need to record the trans-
fer, but not as an expense or income item. Examples include:

• transferring cash from your current account to a savings account.

• paying off the balance on a credit card account.
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4.6.6 Loan Repayments

Loan repayments are more involved than they first appear, because they involve
two components: a cash transfer (the loan repayment part) and an expense (the
interest payment part). To make this more difficult, banks use complex formulae
to calculate the interest amount and the repayment amount. Thus, it can be
difficult even to find out what the amounts are.

To further complicate matters, many people are used to considering loan
payments as a monthly expense when in fact it is only the interest component of
each payment that is an expense. It is common for people to focus on cashflows
rather than profit and loss.

Once you know the breakdown between the loan repayment and the interest
amount, you need to enter one transaction to represent the interest expense,
and another transaction to represent the transfer between your bank account
and the liability account (that is, the loan repayment). GnuCash will allow you
to enter a split transaction to handle this repayment in a single transaction.
Split transactions will be covered in a future version of this document.

4.7 Account Reconciliation

4.7.1 Background

For certain accounts—most commonly bank accounts and credit accounts—
you will receive regular account statements from the financial institution that
provides the account. It is prudent, of course, to check these statements to
ensure that the bank or credit company has not made any errors recording your
transactions. At the same time, you can check that you, yourself, have not made
any errors recording the transactions in GnuCash.

At first glance, you might think you could just check that the account balance
on the statement matches the account balance in GnuCash. Sometimes that will
work, but the balances can differ for a variety of reasons:

• you may have written cheques that have not yet been presented to the
bank. These transactions will be recorded in GnuCash, but not on your
bank statement.

• the bank statement may include transactions that you have not yet recorded
in GnuCash. Common examples include bank fees and interest.

• the bank may have made an error recording transactions on their system,
or you may have made an error recording your transactions in GnuCash.

The process of explaining—or reconciling—the difference between the two
balances is called account reconciliation. You can perform an account reconcili-
ation using a pencil and paper, but GnuCash includes a handy feature to make
reconciling your accounts relatively painless.

4.7.2 A Worked Example

An example is probably the best way to explain how the account reconcilia-
tion procedure works. Suppose that for the month of January 2002, you have
recorded the following transactions in your bank account:
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Date: Cheque: Description: Amount:

11-Jan-2002 - Salary for January 1000
15-Jan-2002 1 Rent -500
19-Jan-2002 2 Petrol -25
27-Jan-2002 3 Electricity -75
28-Jan-2002 4 Joe Bloggs -30
31-Jan-2002 5 Stereos Unlimited -350
31-Jan-2002 Balance 20

Here’s how the account appears in GnuCash:

Early in February, you receive the following statement from your bank:

Date: Cheque: Description: Amount:

11-Jan-2002 - Salary for January 1000
15-Jan-2002 1 Rent -500
20-Jan-2002 2 Petrol -25
20-Jan-2002 - Bank Fees -5
20-Jan-2002 - Interest 1
30-Jan-2002 3 Electricity -75
30-Jan-2002 4 Joe Bloggs -30
31-Jan-2002 Balance 366

The balance in your accounts (20) does not match the balance on the bank
statement (366).

In this example, the reasons for the different balances are fairly obvious:
the bank statement includes two transactions (bank fees and interest) that
you haven’t recorded in GnuCash yet, and GnuCash includes one transaction
(cheque 5) which hasn’t made it onto the bank statement yet.

To reconcile the account in GnuCash, open the account register window and
select Reconcile... from the Account menu. This presents the reconciliation
information window :
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In this window you should enter the statement date and balance. After you
click OK, the account reconciliation window is displayed:

In this window, GnuCash displays all the transactions for the account that
have not yet been marked as reconciled. Funds flowing into the account are
shown on the left, and funds flowing out of the account are shown on the right.

At the bottom of the screen, there is a summary of the reconciliation. The
Opening Balance shows the previous reconciled balance for this account (if this
is the first reconciliation for the account, then the balance will be 0.00). The
Closing Balance is the statement balance that you entered in the previous
window. The Reconciled Balance is the balance of all transactions in the
GnuCash account that have been marked as reconciled.

A transaction in GnuCash can be marked as reconciled once it has been
checked and agreed against the account statement. The account reconciliation
window is the only place that you can mark a transaction as reconciled. To do
so, simply click in the R column of the Funds In or Funds Out tables, next to
the transaction you wish to mark as reconciled.

Note that each time you change the status of a transaction, the reconciliation
summary at the bottom of the screen is updated:

If you find transactions on the bank statement that do not appear in the
account reconciliation window, then you need to add them to the GnuCash
account. Click on the New icon in the toolbar, and add the transaction in the
normal way. Onced the reconciled balance matches the statement balance, the
Reconcile icon in the toolbar is enabled—click this icon to change the status
of the transactions that you have indicated are reconciled.
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Returning to the account register window, you can now see that most of the
transactions are marked as reconciled. One item, however, is not yet marked
as reconciled because it has not yet appeared on an account statement (it will
appear on next month’s statement and can be marked as reconciled then).

Once a transaction has been marked as reconciled, GnuCash will warn you
against making any changes to the transaction. In general, if you have checked
the transaction and agreed it against your bank statement, there should be no
need to change it. If you override GnuCash and change the transaction, then
future bank reconciliations may be difficult to complete.
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5 Reports

5.1 Introduction

GnuCash is supplied with a range of useful reports. In this section, I describe
the five reports that form the core of the GnuCash reporting facilities:

Report: Description:

Account Register A listing of the transactions in an account.
Account Summary A summary of the balances in a selection of accounts.
Transactions A summary of the transactions in one or more ac-

counts.
Profit and Loss A summary of income and expenses for a fixed period.
Balance Sheet A summary of assets and liabilities at a fixed date.

GnuCash has many other reports—these are documented in a later section.

5.2 The Account Register Report

5.2.1 Overview

The Account Register Report provides a list of all, or a subset, of the transactions
for an account. For example:

Highlighted figures on the report are hyperlinks—clicking on them takes you
to the corresponding transaction in the account register window.

5.2.2 Generating the Report

The report can only be created from an account register window. To create a
report, select the Report menu item from the Register menu, or click on the
Report icon in the toolbar.

The report will include all the transactions that are displayed in the account
register—in other words, it takes the same date range as the account register
window is currently displaying.

The report will appear in the main GnuCash window.
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5.2.3 Report Options

You can modify the report by clicking on the Options icon in the toolbar.5 The
report options window appears, with the General tab displayed:

The options on this tab are described here:

Option: Description:

Report Name The name used to identify the report in the main GnuCash
window (on the notebook tabs and in the Window menu.

Stylesheet The stylesheet used to format the report (HTML is used for
the reports).

Title The report title—appears within the report.

The Display tab contains options for which transaction items to display in
the report:

5There does not appear to be a corresponding menu item.
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The options on this tab are described here:

Option: Description:

Date Include the Date field.
Num Include the Num field.
Description Include the Description field.
Account Include the Account field.
Shares Include the Shares field.
Price Include the Price field.
Amount Controls whether there is one (Single) or two (Double)

columns for the transaction amounts. In the latter for-
mat, debits are shown in the first column, and credits
in the second column.

Running Balance Include a running balance for the account.
Totals Include totals on the report.

You can format the Account Register Report as an invoice by selecting the
invoice option:

The invoice will have your name and address at the top (taken from the
GnuCash Preference settings), and the name and address of the client (taken
from the above options).

5.3 Account Summary Report

5.3.1 Overview

The Account Summary Report provides a listing of accounts (and balances) as
at a particular date. For example:

25



By default, the report will include all accounts, but you have the option to
select a subset of accounts.

5.3.2 Generating the Report

You can generate the report from the main GnuCash window. Open the Reports
menu and select the Account Summary menu item. GnuCash will create a report
using default options—you can modify these after the report is created.

5.3.3 Report Options

To change the report options, click on the Options icon in the toolbar.6 The
report options window appears, with the General tab displayed:

6There does not appear to be a corresponding menu item.
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The options on this tab are described here:

Option: Description:

Report Name The name used to identify the report in the main Gnu-
Cash window (on the notebook tabs and in the Window

menu.
Stylesheet The stylesheet used to format the report (HTML is

used for the reports).
Date The balance date for the report. The account balances

on the report include transactions up to and including
the balance date. For convenience, a drop down list is
provided containing common date selections.

Report’s Currency The currency for the report. You need to have ex-
change rates available in GnuCash before you change
the default currency.

Price Source Controls the way that GnuCash looks up exchange
rates.

The Accounts tab allows you to select which accounts should appear on the
report—all accounts are selected by default:

The Display tab controls some of the items that are displayed on the report:
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The options on this tab are described here:

Option: Description:

Group the accounts Group the accounts into categories: assets, li-
abilities, equity, income and expenses.

Show balances for

parent accounts

Show balances for the parent accounts.

Show subtotals Show subtotals on the report for each level in
the account tree.

Show foreign

currencies/shares of

stock

Show currencies and number of shares in an
additional column on the report.

Show exchange rates Includes a table of exchange rates at the bot-
tom of the report.

5.4 The Transaction Report

5.4.1 Overview

The Transaction Report lists transactions from one or more accounts that occur
within a date range. For example:

The highlighted account names are hyperlinks—if you click on one of these,
GnuCash will open the account register window for the account.
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5.4.2 Generating the Report

To generate the report, go to the Reports menu and select the Transaction
Report menu item. GnuCash will create a report using default options (a list
of transactions in income accounts between the beginning of the current year
and today). You can modify these options after the report is created.

5.4.3 Report Options

To change the report options, click on the Options icon in the toolbar.7 The
report options window appears, with the General tab displayed:

The options on this tab are described here:

Option: Description:

Report Name The name used to identify the report in the main GnuCash
window (on the notebook tabs and in the Window menu.

Stylesheet The stylesheet used to format the report (HTML is used for
the reports).

From The start date for transactions included in the report. For
convenience, a drop down list is provided containing common
date selections.

To The end date for transactions included in the report. For
convenience, a drop down list is provided containing common
date selections.

Style Controls whether one (Single) or two (Columns) are used to
display the transaction amounts.

The Accounts tab allows you to control from which accounts the transactions
in the report are obtained:

7There does not appear to be a corresponding menu item.
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The Display tab controls which transaction items are displayed on the report:

The items on this tab are:

Option: Description:

Date Include the Date field.
Num Include the Num field.
Description Include the Description field.
Memo Include the Memo field.
Account Include the Account field.
Use Full Account Name? Use the full account name.
Other Account Include the transfer account.
Shares Include the Shares field.
Price Include the Price field.
Amount Include the Amount field.
Running Balance Include a running balance on the report.
Totals Include totals on the report.
Sign Reverses? Reverse the signs for transaction amounts in

certain account types. This makes the num-
bers more intuitive to look at.

The Sorting tab controls the order in which the transactions appear on the
report:
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The items on this tab control the sorting and totalling for the report.

5.5 The Profit and Loss Report

5.5.1 Overview

The Profit and Loss Report summarises your income and expenses during a
specific period of time. For example:

The difference between income and expenses for a period is your profit or
loss, which directly translates into a change in your net wealth.

5.5.2 Generating the Report

To generate the report, go to the Reports menu and select the Profit and
Loss menu item from the Income and Expense submenu. GnuCash will create
a report using default options—you can modify these options after the report
is created.
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5.5.3 Report Options

To change the report options, click on the Options icon in the toolbar.8 The
report options window appears, with the General tab displayed:

The options on this tab are described here:

Option: Description:

Report Name The name used to identify the report in the main Gnu-
Cash window (on the notebook tabs and in the Window

menu.
Stylesheet The stylesheet used to format the report (HTML is

used for the reports).
Date The balance date for the report. The account balances

on the report include transactions up to and including
the balance date. For convenience, a drop down list is
provided containing common date selections.

Report’s Currency The currency for the report. You need to have ex-
change rates available in GnuCash before you change
the default currency.

Price Source Controls the way that GnuCash looks up exchange
rates.

The Accounts tab allows you to select the accounts to be included in the
report. By default, all income and expense accounts are included:

8There does not appear to be a corresponding menu item.
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The Display tab contains options to control how the report is displayed:

5.6 The Balance Sheet Report

5.6.1 Overview

The Balance Sheet Report summarises your assets, liabilities and net worth as
at a point in time. For example:
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The date used for the account balances in the Balance Sheet Report is called
the balance date.

5.6.2 Generating the Report

To generate a Balance Sheet Report, select the Balance Sheet item from the
Assets & Liabilities submenu in the Reports menu on the main GnuCash
screen. By default, the balance date for the report is today.

5.6.3 Report Options

You can tailor the report to suit your requirements by clicking on the Options
icon in the toolbar.9 This options the report options window, with the General
tab displayed:

The options on this tab are described here:
9There does not appear to be a corresponding menu item.
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Option: Description:

Report Name The name used to identify the report in the main Gnu-
Cash window (on the notebook tabs and in the Window

menu.
Stylesheet The stylesheet used to format the report (HTML is

used for the reports).
Date The balance date for the report. The account balances

on the report include transactions up to and including
the balance date. For convenience, a drop down list is
provided containing common date selections.

Report’s Currency The currency for the report. You need to have ex-
change rates available in GnuCash before you change
the default currency.

Price Source Controls the way that GnuCash looks up exchange
rates.

The Accounts tab allows you to select the accounts to include on the report:

The Account Display Depth field controls which accounts are displayed in
the report, according to their depth in the account tree. Top level accounts are
at level 1, accounts directly below the top level accounts are at level 2, and so
on.

Finally, you can control some of the display options:
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There are four checkboxes on this tab:

Option: Description:

Show balances for

parent accounts

If selected, balances are displayed for parent
accounts.

Show subtotals Show subtotals. We could do with an expla-
nation here describing what gets subtotalled.

Show Foreign Currencies -
Show Exchange Rates -
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6 Shares and Unit Trusts

6.1 Introduction

GnuCash includes a simple, but effective, facility for recording your investments
in shares, mutual funds and unit trusts. This facility is described in this section.

6.2 Broker Accounts

Before you begin trading shares, you will usually open an account with a
broker—the broker account—and deposit cash in the that account to pay for
your share purchases and any associated brokerage costs. This account will
record all the cash transactions between you and your broker. When you sell
shares, the proceeds of the sale will be transferred to your account.

Most brokers require you to maintain a positive cash balance in your account,
and will usually pay interest periodically.

There is no special account type in GnuCash for broker accounts—you should
set up this account in GnuCash as a regular asset account.

If you use the services of more than one broker, set up additional accounts
for each broker.

6.3 Share Accounts

A share account is a special type of asset account that you use to track your
holdings when you buy and sell shares in a company. You can add as many
share accounts to your account tree as you require to track all of your share
investments.

When you are setting up a share account, you must fill in the Security
field.10 If you click on the Select... button at the right of the security
field, you will be presented with a small window from which you can select an
existing security or define a new one. Don’t be put off by the fact that GnuCash
initially displays an entry for a currency—the same window is used for selecting
currencies and shares/unit trusts:

Click on the New... button to create a new security:

10GnuCash uses the term security to refer to shares, unit trusts and currencies.
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The fields on the security definition window are as follows:

Field: Description:

Full name The name of the company or fund.
Symbol/abbreviation The symbol for the company or fund. This is impor-

tant if you are using the GnuCash facility for down-
loading automatic price updates. If you are manually
updating prices, this field is less important.

Type The type of security. Select an entry from the list, or
type a new one.

CUSIP or other code The CUSIP code for the security.
Fraction traded Usually 1/1 for shares, but unit trusts will often trade

in fractional units.

After you click the OK button, the previous security selection window returns,
this time displaying the new security you have defined—click OK to select it:

The completed account definition now looks like this:

You can edit the account details and the security definition at any time, if
you have made a mistake.
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6.4 Buying and Selling Shares

To record a share purchase, open the share account and enter the details in
the account register window. You will notice that some of the column headings
in the account register window are different for share accounts as compared to
regular accounts:

You need to fill in the following fields:

Field: Description:

Date The date of the transaction.
Description A short description of the field.
Transfer The broker account (if you have set one up), or your current

account if you are paying cash for the shares.
Shares The number of shares.
Price The price per share.

GnuCash will calculate the total purchase cost by multiplying the number
of shares by the price paid.

To record the transaction costs associated with this deal, you have two op-
tions:

• enter a transaction split, to include the broker fees directly with the share
transaction.

• record the broker fees as an expense separately via the broker account.

6.5 Dividends

When you hold shares in a company, you will usually receive a regular dividend
payment. To record these, you need to set up an income account for dividends.

Debit your bank account and credit your dividend income account. Note
that no entry is required in the share account.

6.6 Updating Share Prices

Over time, share prices will rise and fall according to expectations about the
future earning power of the company. To get an accurate picture of your financial
position, you need to revalue your investments at current market prices.

GnuCash has a simple facility for recording share prices through time. Refer
to the Tools section (8) for details.
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6.7 Reporting

GnuCash includes your investments on the Balance Sheet Report , at cost or
using current market valuations (if you have the prices available).

The Investment Portfolio Report also provides information about your shares
and mutual fund investments.

6.8 Stock Splits

6.8.1 Overview

A stock split is where a company issues new shares—at no cost—to existing
shareholders on a pro-rata basis. For example, in a 1-for-10 stock split, a com-
pany gives every shareholder one new share for every ten they already hold.

To record a stock split, you need to enter a transaction in your stock ac-
count that shows that you have acquired shares at no cost. The value of this
transaction is zero (and so GnuCash doesn’t insist on a transfer account), but it
enables GnuCash to keep track of exactly how many shares you own, and what
is the total cost of those shares.

You can enter this transaction manually, or you can use the stock split druid.

6.8.2 The Stock Split Druid

The stock split druid leads you through a sequence of steps to easily create
a stock split transaction. The transaction is generated automatically, on the
basis of some details that you are prompted to enter. This is the easiest way
to handle a stock split, but you should always check the transactions that the
druid creates, just to be sure it has done the right thing.

You can launch the druid by selecting Stock Split... from the Account
menu, either in the main GnuCash window or in the stock account register
window.

On the first screen, you will see a list of stock accounts from your account
tree:

Select the account for the stock that is being split, then click the Next button.
In the next screen, you need to enter the split date and the number of shares
you will receive as a result of the split:
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You are also given the opportunity to enter a new stock price—in a stock
split, the share price adjusts downwards to reflect the increased number of shares
on issue. This is optional, you can leave this blank if you want to. Click the
Next button to proceed. On the next screen, you can enter a cash amount (if
any) that you are receiving in connection with the stock split:

The final screen informs you of your options to review the details you have
entered, to cancel the druid (no changes are made to your accounts in this case),
or to create the transaction:

If you proceeded to create the transaction, be sure to review what the druid
has done for you.
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7 Other Reports

7.1 Introduction

In this section, I describe some of the other reports—many of them graphical—
not covered in the earlier reporting section.

7.2 The Asset Barchart Report

7.2.1 Overview

This report shows a stacked bar chart summarising the value of your assets at
certain points in time.

7.3 The Asset Piechart Report

7.3.1 Overview

This report shows a pie chart summarising the value and allocation of your
assets at a certain point in time.

42



7.4 The Liability Barchart Report

7.4.1 Overview

This report shows a stacked bar chart summarising the value of your liabilities
at certain points in time.
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7.5 The Liability Piechart Report

7.5.1 Overview

This report shows a pie chart summarising the value of your liabilities at a
certain point in time.

7.6 The Average Balance Report

7.6.1 Overview

Not yet documented.

7.7 The Net Worth Barchart Report

7.7.1 Overview

This report shows a bar chart summarising your net worth at certain points in
time.

7.8 The Investment Portfolio Report

7.8.1 Overview

A summary of your investments in shares and mutual funds.

7.9 The Price Scatterplot Report

7.9.1 Overview

A plot of share prices through time.
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7.10 The Tax Report

7.10.1 Overview

Not yet documented.

7.11 The Expense Barchart Report

7.11.1 Overview

A stacked bar chart of your expenses through time.

7.12 The Expense Piechart Report

7.12.1 Overview

A pie chart showing a break down of your expenses over a period of time.

7.13 The Income Barchart Report

7.13.1 Overview

A stacked bar chart showing your income at various points in time.

7.14 The Income Piechart Report

7.14.1 Overview

A pie chart showing a breakdown of your income for a specified period of time.

7.15 The Income/Expense Chart Report

7.15.1 Overview

A bar chart showing income and expenses for a specific period of time.
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8 Tools

8.1 Overview

GnuCash includes some tools that can be accessed from the Tools menu in the
main GnuCash window.

8.2 Find Transactions

After you have been using GnuCash for a while, you will find that you have
defined dozens of accounts and that you have entered hundreds—or perhaps
even thousands—of transactions. This can make it difficult to locate a partic-
ular transaction, especially if you don’t recall the transaction date. The Find
Transactions Tool is designed to help in this situation.

You can open the Find Transactions Tool by selecting Find Transactions
from the Tools menu:

After specifying your selection criteria, click the Find button to search for
matching transactions. After a short delay, the search results window is dis-
played. This is just like the account register window, except that it includes all
transactions that match the search parameters (not just the transactions from
a single account):
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You can generate and print a report for the transactions in the search win-
dow.

8.3 The Commodity Editor

You can use the Commodity Editor to define new commodities or edit existing
commodities in GnuCash:

A commodity (in GnuCash) is a stock, mutual fund, unit trust, currency, or
other tradeable instrument. You need to define commodities so that GnuCash
can obtain prices or rates for those commodities.When you create or edit a
commodity, you need to fill in the fields of the New Currency/Security window :

This is described more fully in section 6.3.
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8.4 The Price Editor

This tool is used to manually edit prices for shares and unit trusts, and also to
update exchange rates for currency accounts. You cannot enter a share price or
exchange rate until you have entered a commodity definition to represent the
underlying item being traded.

If you add a new price, or edit an existing price, you need to fill out the
fields on the price editor window:

You can update prices manually or automatically (if automatic rate collec-
tion is configured for your copy of GnuCash).

8.5 Financial Calculator

GnuCash includes a handy financial calculator for calculating loan repayments:
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This will be documented in detail in a later version of this document.

49



A GnuCash Menus

A.1 Introduction

This section describes all the menus on the main GnuCash window, and provides
cross-references to other sections of the guide.

A.2 The File Menu

A.2.1 Overview

It has become standard for GUI applications to have a File menu as the first
item on the menubar. Some of the menu items relate to files, but not all of
them! The menu appears as follows:

Refer to the following subsections for details.

A.2.2 New File

Creates a new set of accounts (see section 4.3 for details). GnuCash only allows
you to have one set of accounts open at a time. If you are already working on
another set of accounts, and you have unsaved changes, GnuCash will prompt
you to save your changes before closing the accounts and creating a new set.

A.2.3 Open...

Presents a file open dialog, allowing you to choose a set of accounts to open.
GnuCash only allows you to have one set of accounts open at a time. If you
are already working on another set of accounts, and you have unsaved changes,
GnuCash will prompt you to save your changes before closing the accounts and
creating a new set.

As a convenience, GnuCash displays a list of recently opened files towards
the bottom of the File menu. It is often faster to select a file from there.

A.2.4 Save

Saves any and all changes to the current set of accounts. If you are entering
many transactions in one session, it is a good idea to save your work at regular
intervals.
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A.2.5 Save As...

Saves the current set of accounts under a new name.

You can use any valid file name to save your accounts and transactions. It
is common to use the suffix .xac, but this is not required.

A.2.6 Export Accounts...

Exports your account tree structure to an XML file. Useful if you want to start
a new set of accounts using the same account structure as an existing set of
accounts.

Note that only the account structure is exported, not the transactions.

A.2.7 Import QIF...

Imports data from a QIF-format file. QIF is the Quicken Interchange Format,
a file format used by Quicken (a personal finance manager application that runs
on Microsoft Windows).

Many applications, besides Quicken, can generate files in QIF format, so it
is a useful format to be able to import.

The import process is quite involved, and is not documented here (yet).
Refer to the online documentation for details.

A.2.8 New Account Tree

Opens a new account tree tab or window for the current set of accounts. This
does not create or open a new set of accounts, it just creates another view on
the current set of accounts.

A.2.9 Move To New Window

Opens a new top-level window displaying the current set of accounts.

A.2.10 Close Window

Closes the current tab or window.

It is possible to close all the tabs, including the account tree, so that it looks
like you no longer have a set of accounts open at all. In fact, the accounts are
still open—select the New Account Tree menu item to see that this is the case.

A.2.11 Exit

Exit GnuCash. If you have unsaved changes, GnuCash will prompt you to save
your work before closing.

A.3 The Reports Menu

A.3.1 Overview

This menu contains items for generating (most of) the reports that GnuCash
can generate. The menu appears as follows:
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Refer to the following subsections for details.

A.3.2 Tax Report/TXF Export

Creates a Tax Report. Refer to section 7.10 for details.

A.3.3 Account Summary

Creates an Account Summary Report. Refer to section 5.3 for details.

A.3.4 Transaction Report

Creates a Transaction Report. Refer to section 5.4 for details.

A.3.5 Welcome Extravaganza

The Welcome Extravaganza menu item is found under the Utility submenu.
Selecting this menu item creates a composite report that is not covered in this
document.

A.3.6 Multicolumn View

The Multicolumn View menu item is found under the Utility submenu. Se-
lecting this menu item creates a composite report that is not covered in this
document.

A.3.7 Frame URL

The Frame URL menu item is found under the Utility submenu. Selecting this
menu item creates a report that displays the content from a URL. I’m not sure
what the intent of this report is.

A.3.8 Hello, World

The Hello, World menu item is found under the Utility submenu. Selecting
this menu item creates a report that is intended as a demonstration for GnuCash
Developers.

A.3.9 Balance Sheet

Creates a Balance Sheet Report. Refer to section 5.6 for details.

A.3.10 Asset Barchart

Creates an Asset Barchart Report. Refer to section 7.2 for details.

52



A.3.11 Average Balance

Creates an Average Balance Report. Refer to section 7.6 for details.

A.3.12 Liability Barchart

Creates a Liability Barchart Report. Refer to section 7.4 for details.

A.3.13 Investment Portfolio

Creates an Investment Portfolio Report. Refer to section 7.8 for details.

A.3.14 Net Worth Barchart

Creates a Net Worth Barchart Report. Refer to section 7.7 for details.

A.3.15 Liability Piechart

Creates a Liability Piechart Report. Refer to section 7.5 for details.

A.3.16 Price Scatterplot

Creates a Price Scatterplot Report. Refer to section 7.9 for details.

A.3.17 Asset Piechart

Creates an Asset Piechart Report. Refer to section 7.3 for details.

A.3.18 Profit and Loss

Creates a Profit and Loss Report. Refer to section 5.5 for details.

A.3.19 Expense Piechart

Creates an Expense Piechart Report. Refer to section 7.12 for details.

A.3.20 Expense Barchart

Creates an Expense Barchart Report. Refer to section 7.11 for details.

A.3.21 Income Piechart

Creates an Income Piechart Report. Refer to section 7.14 for details.

A.3.22 Income Barchart

Creates an Income Barchart Report. Refer to section 7.13 for details.

A.3.23 Income/Expense Chart

Creates an Income/Expense Chart Report. Refer to section 7.15 for details.
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A.4 The Tools Menu

A.4.1 Overview

This menu provides access to some of the tools that have been implemented in
GnuCash. The menu appears as follows:

Refer to the following subsections for details.

A.4.2 General Ledger

Opens the general ledger window. Not yet documented.

A.4.3 Commodity Editor

Opens the commodity editor window. Refer to section 8.3 for details.

A.4.4 Price Editor

Opens the price editor window. Refer to section 8.4 for details.

A.4.5 Financial Calculator

Opens the financial calculator window. Refer to section 8.5 for details.

A.4.6 Find Transactions

Opens the find transactions window. Refer to section 8.2 for details.

A.5 The Account Menu

A.5.1 Overview

Contains menu items that relate to accounts. This menu is only available when
you are viewing the account tree in the main GnuCash window. The menu
appears as follows:
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Refer to the following subsections for details.

A.5.2 Open Account

Opens an account register window for the account that is selected in the account
tree.

A.5.3 Open Subaccounts

Opens a General Ledger window for all the subaccounts under the account se-
lected in the account tree.

A.5.4 Edit Account

Opens a window that allows you to change the properties of an account.

A.5.5 Reconcile...

Opens the account reconciliation window for the account selected in the account
tree. Refer to section 4.7.2 for details.

A.5.6 Transfer...

Opens a window for transferring an amount from one account to another.

A.5.7 Stock Split...

Opens the Stock Split druid. Refer to section 6.8 for details.

A.5.8 New Account...

Creates a new account. Refer to section 4.4 for details.

A.5.9 Delete Account

Deletes the account selected in the account tree.

A.5.10 Scrub Account

Checks the selected account for unbalanced transactions, and adds balancing
items where necessary.

A.5.11 Scrub Subaccounts

Checks the selected account (and sub accounts) for unbalanced transactions,
and adds balancing items where necessary.

A.5.12 Scrub All

Checks all accounts for unbalanced transactions, and adds balancing items where
necessary.
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A.5.13 Tax Information

Opens a window for editing the tax information for accounts. Not documented
here yet.

A.6 Settings

A.6.1 Overview

This menu contains items for changing global GnuCash settings. The menu
appears as follows:

Refer to the following subsections for details.

A.6.2 StyleSheets...

Allows you to change the properties of the two style sheets that are provided
with GnuCash version 1.6.2.

A.6.3 Preferences...

Allows you to set your own preferences for the way GnuCash works. The pref-
erence settings are documented in Appendix C.

A.7 Windows

In this menu there will be one item for each account register, report or account
tree that you have opened. Selecting one of these switches the display to show
the selected item.

A.8 Help

A.8.1 Overview

This menu contains items for obtaining information about GnuCash. The menu
appears as follows:

Refer to the following subsections for details.

A.8.2 Manual

Displays the online user guide.
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A.8.3 Tips of the Day

Displays the tip of the day window. You should review these tips, as they
contain useful information about using GnuCash. In version 1.6.2 of GnuCash,
there are about 20 tips in total.

A.8.4 About...

Displays information about GnuCash, including the version number. Here is
the about window from the version of GnuCash that I am using:
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B Account Register Menus

B.1 Introduction

This section describes all the menus on the account register window, and pro-
vides cross-references to other sections of the guide.

B.2 The Register Menu

B.2.1 Overview

This menu contains items for controlling the appearance and behaviour of the
account register window, and also some report items. The menu appears as
follows:

Refer to the following subsections for details.

B.2.2 Style

Sets the register style to one of the following options:

Style: Description:

Basic Ledger The default.
Auto-Split Ledger Same as Basic Ledger except that new transactions

always show the split details.
Transaction Journal Shows each transaction on multiple lines including all

memo fields, and includes a running balance for the
account.

In addition to selecting the style, you can also select the Double Line item
to show each transaction item on two lines instead of one (the additional line
shows the Action and Notes fields for the transaction item).

B.2.3 Sort Order

Selects the sort order for viewing the transactions in the account:
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Order: Description:

Standard order The default.
Sort by Date Ascending date order.
Sort by date of entry Date entry order (note that the transaction’s

date of entry is not shown anywhere).
Sort by statement date Statement date.
Sort by Num Ascending order according to the entry in the

Num field for the transaction.
Sort by Amount Ascending order according to the transaction

amount.
Sort by Memo Ascending order according to the memo entry.
Sort by Description Alphabetical order on the Description field.

The sort order affects only your view of the transactions, not the way they
are recorded.

B.2.4 Date Range

Sets the date range for transactions to display in the account register window.
To select a subset of the transactions, fill in the fields on the date range selection
window:

By default, all transactions are displayed.

B.2.5 Report

Creates a Register Report. This displays all the transactions in the account
register window. See section 5.2 for details.

B.2.6 Invoice

Creates an Invoice Report from the transactions in the account register window.

B.2.7 Print

Prints the transactions in the account register window.

B.2.8 Close

Closes the account register window.
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B.3 The Edit Menu

B.3.1 Overview

The menu appears as follows:

Refer to the following subsections for details.

B.3.2 Cut

Cuts the selected text, storing it on the clipboard.

B.3.3 Copy

Copies the selected text, storing it on the clipboard.

B.3.4 Paste

Pastes the contents of the clipboard to the current field.

B.3.5 Cut Transaction

Cuts the selected transaction to the transaction clipboard.

B.3.6 Copy Transaction

Copies the selected transaction to the transaction clipboard.

B.3.7 Paste Transaction

Pastes a transaction from the transaction clipboard to the current account.

B.4 The Account Menu

B.4.1 Overview

Contains menu items that relate to the account. The menu appears as follows:

Refer to section A.5 for details.
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B.5 The Transaction Menu

B.5.1 Overview

The menu appears as follows:

Refer to the following subsections for details.

B.5.2 Enter

Records the current transaction.

B.5.3 Cancel

Cancels the current transaction by clearing all the input fields.

B.5.4 Delete

Deletes the current transaction.

B.5.5 Duplicate

Duplicates the current transaction. You will be given the opportunity to edit
the transaction Date and Num fields:

Click OK to duplicate the transaction, but with the new Date and Num items.

B.5.6 Split

Displays the list of splits for the current transaction.
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B.5.7 Blank

Moves the cursor to the blank transaction at the bottom of the account register
window.

B.5.8 Jump

Jumps to the corresponding entry in the other account for this transaction.

B.5.9 Scrub All

Identifies and fixes problems for all transactions displayed in the account register
window.

B.5.10 Scrub Current

Identifies and fixes problems for the current transaction.

B.5.11 Invoice

Generates an invoice based on the selected transaction.

B.5.12 Print Check

Prints a cheque for the selected transaction.

B.6 Help

B.6.1 Help

Displays the online user guide.
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C GnuCash User Preferences

C.1 Overview

You can configure GnuCash to work in a way that suits you by changing the
user preferences. Select the Preferences... menu item from the Settings
menu:

This will display the Preferences Window, with the General tab selected.
Each tab on this window is described in the following subsections.

C.2 General Settings

The General tab contains a miscellaneous collection of settings for controlling
the GnuCash environment:

63



Each item on this tab is described in the following subsections.

C.2.1 Save Window Geometry

When the Save Window Geometry checkbox is selected, GnuCash records the
size of each type of window. The next time GnuCash opens a window of that
type, it uses the recorded size rather than the default size.

C.2.2 Toolbar Buttons

The Toolbar Buttons combobox controls the appearance of the buttons on the
toolbar. There are three options:

Option: Description:

Icons and Text Toolbar items shown as icons with text labels (the
default).

Icons only Toolbar items shown as icons only (no text).
Text only Toolbar items shown as text only (no icons).

The default value is Icons and Text.

C.2.3 Application MDI Mode

The Application MDI Mode combobox controls the way that GnuCash presents
multiple windows (MDI stands for multi-document interface). The available
options are:

Option: Description:

Notebook GnuCash opens a new tab on the main window, when-
ever necessary.

Top-level GnuCash opens a new top level window, whenever nec-
essary.

Single Window GnuCash displays just one window at a time. You
can select which window is displayed from the Window

menu.
Use GNOME Default Behaviour is controlled by the GNOME default.

The default selection is Notebook.

C.2.4 Account Separator

The symbol used to separate account names in the account hierarchy. Options
include:

Option: Description:

: Colon Separate account names with a colon.
/ Slash Separate account names with a slash.
\ Backslash Separate account names with a back-slash.
- Dash Separate account names with a dash.
. Period Separate account names with a period.

The default is a colon (:).
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C.2.5 Reversed Balance Account Types

The Reversed Balance Account Types combobox determines which accounts
have the sign of their account balances reversed for display purposes.

In general, GnuCash displays debit balances as positive numbers and credit
balances as negative numbers. This makes the system more intuitive. However,
sometimes this convention results in numbers that are the reverse of what we
are used to seeing. So with this option, you can control the type of accounts
that have their signs reversed when account balances are shown:

Option: Description:

Income & Expense Income and expense accounts.
Credit Accounts Credit card accounts.
None No accounts.

The default value is Credit Accounts.

C.2.6 Use Accounting Labels

Select this option and GnuCash will use the terms debit and credit. Leave this
option unselected (the default) and GnuCash will use more intuitive terms—for
example, deposit and withdrawal for a bank account.

C.2.7 Display Tip Of The Day

A “tip of the day” is displayed every time you start up GnuCash (by default).
If you don’t want this, uncheck this option.

C.2.8 Display Negative Amounts In Red

Negative values are displayed in red, by default. If you don’t want this, uncheck
this option.

C.2.9 Automatic Decimal Point

Select this option if you would like GnuCash to automatically insert a decimal
point when you enter a number without a decimal point. Some people find this
convenient because they can enter numerical data more quickly (I’m not one of
them!).

If you select this option, you also need to specify the number of decimal
places (the default is 2).

C.2.10 No Account List Setup On New File

When you create a new accounts file, GnuCash displays the New Account Hier-
archy Setup druid. You can just click on the cancel button if you don’t want to
use the druid, but if you would rather that it didn’t appear at all, then select
this option.
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C.3 International Settings

GnuCash is used in many countries throughout the world. These settings allow
you to customise GnuCash to suit you, wherever you happen to live:

The items on this tab are described in the following subsections.

C.3.1 Date Format

You can set the date format to any of the following:

Option: Description:

US The date format commonly used in the United States of America
(mm/dd/yyyy).

UK The date format commonly used in the United Kingdom
(dd/mm/yyyy).

Europe The date format commonly used in many European countries
(dd.mm.yyyy).

ISO The date format specified by the International Standards Organ-
isation (yyyy-mm-dd).

Locale The date format specified by the locale setting on your machine.

C.3.2 Default Currency

Sets the default currency for transactions in GnuCash.

C.3.3 Use 24 Hour Time Format

Uses 24 hour time format—not sure where though!

C.3.4 Enable EURO Support

Enables support for the EURO—this will be documented in a later version of
this guide.
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C.4 Network Settings

The Network Settings tab contains preferences for the use of network services:

These network services were never fully implemented, so these settings are
redundant.

C.5 QIF Import Settings

Settings for importing QIF files. QIF is the “Quicken Interchange Format”, a file
format used by Quicken (a personal finance application for Microsoft Windows).
Many other applications can also generate QIF-format files.
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By default, the QIF Import druid will provide lengthy explanations of the
import process. You can switch this behaviour off here.

C.6 Reconciliation Settings

Settings that affect the account reconciliation process:

Option: Description:

Automatic credit card

payments

Automatically generate a payment on comple-
tion of an account reconciliation if the account
type is Credit Card. Selected by default.

Check off cleared

transactions

Cleared transactions are automatically
checked off in the reconciliation window.
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C.7 Register Settings

Settings that control the appearance and behaviour of the account register win-
dow :

Each item on this tab is documented in one of the following subsections.

C.7.1 Default Register Style

Controls the default style for the account register window:

Option: Description:

Ledger Ledger style.
Auto-Ledger Auto-ledger style.
Journal Journal style.

C.7.2 Double Line Mode

In double line mode, each transaction in an account is presented on two lines.
The second line contains the Action and Notes fields for the transaction. The
default is single line mode.

C.7.3 Auto-Raise Lists

As you type the name of an account in the account register window, the list
of all accounts is automatically displayed. This setting turns off this default
behaviour.

C.7.4 Show All Transactions

When you open an account register, by default Gnucash shows all transactions.
If you deselect this option, GnuCash will choose a default date range.
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You can override this setting in the Account Register window via the Date
Range submenu in the Register menu.

C.7.5 Show Vertical Borders

Draws vertical lines between the fields of each transaction in the Account Reg-
ister window. By default, GnuCash does not draw any lines.

C.7.6 Show Horizontal Borders

Draws horizontal lines between the fields of each transaction in the Account
Register window. By default, GnuCash does not draw any lines.

C.7.7 Enter Moves to Blank Transaction

Controls the behaviour of the RETURN or ENTER key. By default, pressing
ENTER will move to the next transaction. If this option is selected, pressing
the ENTER key will move to the blank transaction at the bottom of the Account
Register.

C.7.8 Confirm Before Changing Reconciled

GnuCash will confirm any changes to reconciled transactions. If you don’t want
this, deselect this option (be careful!).

C.7.9 Register Font

The font used to display transactions in the Account Register. The available
options will depend on the fonts that are installed on your system.

C.7.10 Register Hint Font

The font used to display transaction hints in the Account Register. Transaction
hints are small text items that are displayed in empty text fields to guide the
user—they give hints on the type of data that should be entered in a particular
field.

C.8 Register Color Settings

This tab allows you to change the colors used in the account register window :
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C.9 User Information

You can enter your name and address on the User Info tab:

GnuCash uses your name and address at the top of invoice reports, if you
generate them. I am not aware of the information being used anywhere else.

71


	Introduction
	What is GnuCash?
	This Document
	Updates
	Important Notice
	Feedback

	More About GnuCash
	The Gnome Project
	GnuCash Development
	The GnuCash Licence
	Versions
	Getting Support
	Reporting Bugs

	Basic Accounting
	Introduction
	Accounts and Transactions
	The Accounting Equation
	Double Entry Accounting Examples
	Equity Accounts
	Looking Back

	Accounts in GnuCash
	Account Types
	The Chart of Accounts
	Creating a Set of Accounts
	Creating An Account
	Entering Transactions
	Common Transaction Types
	Account Reconciliation

	Reports
	Introduction
	The Account Register Report
	Account Summary Report
	The Transaction Report
	The Profit and Loss Report
	The Balance Sheet Report

	Shares and Unit Trusts
	Introduction
	Broker Accounts
	Share Accounts
	Buying and Selling Shares
	Dividends
	Updating Share Prices
	Reporting
	Stock Splits

	Other Reports
	Introduction
	The Asset Barchart Report
	The Asset Piechart Report
	The Liability Barchart Report
	The Liability Piechart Report
	The Average Balance Report
	The Net Worth Barchart Report
	The Investment Portfolio Report
	The Price Scatterplot Report
	The Tax Report
	The Expense Barchart Report
	The Expense Piechart Report
	The Income Barchart Report
	The Income Piechart Report
	The Income/Expense Chart Report

	Tools
	Overview
	Find Transactions
	The Commodity Editor
	The Price Editor
	Financial Calculator

	GnuCash Menus
	Introduction
	The File Menu
	The Reports Menu
	The Tools Menu
	The Account Menu
	Settings
	Windows
	Help

	Account Register Menus
	Introduction
	The Register Menu
	The Edit Menu
	The Account Menu
	The Transaction Menu
	Help

	GnuCash User Preferences
	Overview
	General Settings
	International Settings
	Network Settings
	QIF Import Settings
	Reconciliation Settings
	Register Settings
	Register Color Settings
	User Information


